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1 Introduction 
 

This software provides convenient control of your KERN microscope camera, as well 
as the ability to capture, display, and manage images and videos for your analysis. 
Enjoy precise image acquisition and intuitive operation for use in laboratories, 
research, and education. 
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2 Safety Instructions 
 

• The software can only be used with the specified KERN microscope cameras. 

• Save data in compliance with current data protection regulations. 

• Store the microscope and camera in a clean, dry location and use the 
microscope’s dust cover for protection. 
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3 System Requirements 
 

Model KERN OXM 903 

Supported Operating Systems Windows 7 or later 

CPU Intel Core i3 or equivalent 

Clock Speed 2.5 GHz 

RAM 2 GB 

SSD-Storage 128 GB SSD 

Graphics Card NVIDIA GeForce RTX 3060 or 
equivalent 

Display 13" Full HD, 1920x1080 

Compatible Cameras ODC 825, 832, 841, 852, 861, 874, 881, 
895 

Higher specifications are recommended for optimal performance. 
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4 Installation 
 

1) Download the installation file from our website: 

https://www.kern-sohn.com/shop/de/downloads/ 

The free microscope camera software VIS Lite can be found under the 
Software menu. 

2) Run the setup and follow the on-screen instructions. 

3) License activation is not required. 

https://www.kern-sohn.com/shop/de/downloads/
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5 Getting Started 
 

1) Connect the camera to the computer. 
2) Launch the software using the desktop icon. 

 
3) Select your camera from the camera list, 

for example, the ODC 832. 
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6 Operation 
The camera software offers various menu sections: 

Main Menu, Camera Configuration, and Tools. 

 

6.1 Main Menu 

 
The main menu consists of: 

(Explanation from left to right) 

→ Open File 

→ Save 

→ Quick Save 

→ Start Timelapse (Auto Capture) 

→ Zoom (10 % - 400 %) 

→ Settings Options (Storage Location, Language, Measurement Parameters, Object 
/ Color Selection, Magnification) 

→ Version Info 

→ Select Unit 

→ Magnification 

→ Delete 
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6.1.1 Save – Quick Save 

 
Save  
 
Function: 
Saves the changes made to the current image to a file without closing the image 
window. 
 
Details: 
If the image already has a file name, it will simply be overwritten. 
If the image was newly created (e.g., by camera capture or “Paste as New File”), a 
“Save As” dialog will open to define the file name, storage location, and format. 
The user must manually select the storage location and format. 
 
Shortcut: Ctrl + S 
 
 
 
Quick Save  
 
Function: 
Immediately saves a newly created or pasted image without requiring the user to 
define storage location, file name, or format. 
 
Details: 
Used for images that have just been captured or inserted. 
The software applies the predefined rules from Options > Preferences > Quick Save 
(e.g., default folder, file name pattern, format). 
Optionally, a rename dialog may appear if this setting is enabled. 
 
Shortcut: Ctrl + Q 
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6.1.2 Delete 

 

Function: 
Removes selected elements from the current window. 
 
 
Files in the Browse/Thumbnail window: 
Deletes image files from the directory (they are moved to the Recycle Bin and can be 
restored). 
Selection is made by clicking, multiple selection with CTRL or SHIFT. 
 
Shortcut: Delete key or Right-click → Delete. 
 
 
Measurement objects in the image view: 
Removes selected measurement objects from the active layer. 
Selection is made beforehand via Measurement > Select Measurement Object. 
Shortcut: Delete key or Menu Edit > Delete. 
 
 
Important Notes: 
The background layer cannot be deleted, only measurement objects or additional 
layers. 
Deleted files in the Browse window are moved to the Windows Recycle Bin. 
 
For measurement objects: deletion only affects the current layer, not the image itself. 
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6.2 Camera Configuration / Tips & Application 

 

 
 
Note: 
Depending on the camera used, not all functions are active because the 
camera hardware does not support them. Therefore, some functions may be 
hidden after the camera is connected. 
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6.3 Recommendations & Application Tips 

 

6.3.1 Camera List 

 

Tip: Select the correct camera before making any adjustments. If multiple cameras 
are connected, incorrect settings may otherwise be applied. 

 

6.3.2 Capture & Resolution 

 

Recommendation: Use a higher resolution for detailed analysis and a lower 
resolution for quick previews or live streaming. 

Note: Higher resolution requires more processing power. 

 

6.3.3 Exposure & Gain 

 

Tip: Use automatic exposure for consistent results. For very dark samples: Increase 
sensitivity, but be aware of image noise. 
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6.3.4 White Balance 

 

Recommendation: Check white balance regularly, especially when using changing 
light sources. 

Tip: For accurate color reproduction, adjust manually. 

 

6.3.5 Black Balance / Black Level / Color Adjustment 

 

Function: Ensures that the black level in the image is correct by defining a reference 
area as “black.” 

Procedure: In the video window, a magenta frame labeled “Black Balance” appears. 
Drag this frame onto an area that represents pure black. Click Black Balance → The 
software creates a black level map for all subsequent images. 

Manual: The black level can be adjusted using sliders for Red, Green, and Blue. 

Note: After activation, the frame disappears. Defaults resets all values. 

 

 

The black level is the baseline value for the darkest areas of the image. It is defined 
by the black balance and influences overall image dynamics. 
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Falscher Schwarzwert → Bild wirkt milchig oder zu kontrastarm. 

 

 

Function: Ensures that white appears neutral in the image and that colors are 
reproduced accurately. 

Procedure: In the video window, a red frame labeled “White Balance” appears. Drag 
this frame onto a neutral white or gray area. Click White Balance → The software 
creates a color map for all subsequent images. 

Manual: The balance can be adjusted using sliders for color temperature and hue. 

Note: Defaults reset all values. 

 

6.3.6 Power Frequency (Anti-Flicker) 

 

Tipp: For LED or fluorescent lamps, set the appropriate mains frequency (50 Hz / 
60 Hz) to prevent flicker. 
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6.3.7 Frame Rate 

 

Recommendation: Use a higher frame rate for live motion and a lower frame rate for 
static samples (saves resources). 

 

6.3.8 Color / Grey 

 

Tip: Use grayscale mode for pure structure or contrast analysis. 

 

 

6.3.9 Flip 

 
To flip the live image horizontally or vertically. 

 

6.3.10 Sampling 

 
The “Sampling” function in the camera sidebar controls how pixels are read from the 
sensor and processed for preview or image capture. 

Tip: If you select a lower preview resolution, “Bin” is recommended to maintain a good 
signal-to-noise ratio. 
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6.3.11 Bit Depth 

 
Bit depth determines how many brightness levels per color channel can be stored. 

RGB24 = 8 bits per channel (24 bits total) 

RGB48 = 16 bits per channel (48 bits total, for high-quality image storage) 

Note: Higher bit depth provides better detail and dynamic range but also requires more 
memory and processing speed. 

6.3.12 Histogram 

 

The histogram displays the brightness and color distribution of an image or video. It 
is an important tool for assessing exposure and image quality. 

The X-axis of the histogram represents brightness values (left = dark, right = bright). 

The Y-axis shows the number of pixels for each brightness level. 

For color images, the RGB channels (Red, Green, Blue) can be displayed individually 
or combined. 

Recommendation: Check exposure using the histogram – avoid clipped areas 
(overexposure or underexposure). 

 

6.3.13 Dunkelfeld- und Flächefeldkorrektur 
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Reduces thermal noise and pixel artifacts that occur during long exposure times or at 
high gain levels (typical for CMOS or uncooled CCD sensors). 

 

 

Corrects brightness and color deviations in the image caused by uneven illumination 
or optical vignetting. 

Tip: Both corrections significantly improve image quality, especially for quantitative 
measurements or documentation. They should be applied before capturing the actual 
image whenever the lighting or camera settings have been changed. 

 

6.3.14 Fixed Pattern Noise Correction 

 
Recommendation: Enable this feature at high sensitivity settings to minimize 
unwanted noise. 

 

6.3.15 Conversion Gain 

 
Note: Ratio between the electrical charge (electrons) generated in the pixel by light 
and the digital value (ADU – Analog-Digital Unit) output by the A/D converter. 

High conversion: Good for low-light conditions, but increases noise. 

Low conversion: Suitable for bright scenes, providing better signal quality and 
dynamic range. 
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Selection: HCG = High Conversion Gain 

MCG = Medium Conversion Gain 

LCG = Low Conversion Gain 

HDR = High Dynamic Range 

 

6.3.16 Cooling / Heating 

 

Purpose: Reduces thermal noise from the sensor (especially during long exposure 
times or at high gain levels). Stabilizes temperature for reproducible results. 

Typical applications: Fluorescence or long-exposure imaging, high-precision 
quantitative measurements. 

Effect: Less image noise, improved signal quality. Extends sensor lifespan. 

 

 

Purpose: Maintains the sample at a defined temperature (e.g., for live cells or 
chemical reactions). Prevents condensation on the objective or camera under high 
humidity conditions. 

Typical applications: Live-cell imaging (37 °C for cell cultures), experiments involving 
temperature-dependent processes. 

Note: Cooling and heating functions are only available if the camera or system 
includes the required hardware. For standard cameras without temperature control, 
these options are inactive. 
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Cooling: Available only on scientific cameras with an integrated Peltier element or 
external cooling module (ODC 861 only). 

Heating: Usually not integrated in the camera but provided by heated stages or 
incubation systems for samples. 

 

6.3.17 Misc 

 
Sharpness: 

Controls image sharpness. 

Higher value = stronger sharpening, lower value = neutral. 

 

Denoise: 

Reduces image noise. 

Higher value = stronger noise reduction, may smooth out details. 

 

Low Noise / Higher SNR, Lower Frame Rate: 

Activates a mode for noise reduction at the expense of frame rate. 

Ideal for static images, less suitable for live video. 

 

Anti-Shutter Effect: 

Prevents rolling shutter artifacts (e.g., distortions during motion). 

Relevant for CMOS sensors. 
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Debayer: 

Selects the method for converting RAW Bayer data into color images. 

Options: e.g., Bilinear, HQ Linear, VNG (depending on software). 

 

Tone Mapping: 

Controls HDR rendering. 

Options: Enable / Disable / various algorithms. 

 

Shutter Mode: 

Selects the shutter type: Rolling Shutter or Global Shutter (depending on camera). 

Global Shutter = no motion distortion, Rolling Shutter = standard for CMOS. 

 

Presets: 

Resets all values to default. 
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6.4 Tools 

 

 
This menu contains tools for drawing, measuring, and editing: 

(Explanation from left to right) 

 

Basic settings for operating the software and exiting a function 

In MicroscopeVIS2.0Lite, this corresponds to general GUI/options as well as 
canceling or leaving active tools (e.g., by pressing Esc or switching to another tool). 

Windows can be closed with Ctrl+W; global settings are available under Options and 
in the sidebars. 

 

Point 

Measurement object “Point”: Places a marker and displays its coordinates/position; 
often used as a reference for further measurements. 

 

Arrow for highlighting sample features 

Annotation arrow: A graphical marker to emphasize features in the sample; does not 
affect the image (layer-based). 

 

Angle measurement in the sample 

Measurement object “Angle”: Available as 3-point or 4-point angle; output in ° (or 
rad/π adjustable). 

 

Length / Distance measurement 

Measurement object “Line/Segment”: Measures distances between points; variants 
for free, horizontal, vertical, or multi-point segments. 

 

Parallelism measurement 

Measurement object “Parallel Lines” or “Double Parallels”: Checks/visualizes 
distances and parallelism of two-line sets. 

 

Perpendicular measurement to a reference line 

Measurement object “Perpendicular”: Constructs an orthogonal line to a reference 
line and measures its distance. 
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Circle via three-point method for area measurement 

Measurement object “Circle (3-Point)”: Defines a circle from three edge points; 
provides diameter, radius, area. 

 

Freehand line measurement 

Measurement object “Freehand Polyline”: Measures length along a freely drawn path 
(segmented, total length). 

 

Rectangle for feature bounding 

Measurement object “Rectangle”: Usually drawn via two corner points; outputs 
width/height/area; also serves as ROI. 

 

Ellipse for feature bounding 

Measurement object “Ellipse”: Drawn via center/radius or two points; outputs 
major/minor axis, area. 

 

Circle with diameter display 

Measurement object “Circle (Diameter)”: Defines a circle via diameter endpoints; 
shows d, r, circumference, area. 

 

Two circles on the same axis for diameter comparison 

Measurement object “Two Circles on One Line”: Useful for comparing two 
holes/objects along an axis; measures both diameters and distance. 

 

Concentric circles for diameter comparison 

Measurement object “Concentric Circles”: Creates two (or more) circles with the 
same center; compares inner/outer diameter, wall thickness. 

 

Polygon for area measurement 

Measurement object “Polygon”: Arbitrary number of vertices; outputs area, perimeter, 
optionally centroid. 

 

Text field for comments or labels 

Measurement object/annotation “Text”: Labels with configurable font size/style/color; 
appears in measurement table and can be exported to Excel/CSV. 
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Scale bar toggle 

Tool “Scale Bar”: Displays or hides a scale bar; length and unit depend on 
calibration/magnification. 

 

Calibration 

Calibration: Sets the pixel-to-length unit (px → µm/mm etc.); required for accurate 
measurements and scale bar. 

 

Layer Mode 

MicroscopeVIS2.0Lite uses a layer-based approach: Measurements/annotations are 
placed on separate layers above the background image; layers can be 
shown/hidden, named, merged (F2), and exported to Excel (F3). 

 

CSV Export 

Measurement data (length, angle, area, diameter, etc.) can be exported directly from 
the measurement table or layer list as CSV; Excel export is also available. 

 

Stitching 

“Stitching”: Combines multiple overlapping images into a larger field of view; in video 
mode with special options (roll mode, automatic edge cropping, constant exposure). 

 

EDF 

EDF (Extended Depth of Field): Combines a focus stack series (same image size 
required) into a consistently sharp result; fusion methods: Maximum Contrast 
(default), Weighted Average, Overlay. 
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6.4.1 What is the Layer Mode?  

 

 

Layer refers to a software technique where different objects (e.g., measurements, 
annotations) are placed on separate layers above the image. 

Purpose: 

Measurements and annotations can be added without altering the original image. 

Layers can be shown or hidden to control the view. 

Background Layer: 

Contains the actual image. This layer cannot be deleted. 

Measurement Layers: 

Used to place measurement objects (lines, angles, circles, text). 

Operations: 

Create a new layer (Layer > New) 

Delete a layer (only non-active layers) 

Rename a layer 

Set a layer as Active Layer (for editing) 

Show/Hide a layer 

Merge all layers into the image (Fusion to Image – irreversible!) 

 

Why is this important? 

Measurements remain independent of the image and can be exported or modified 
later. 

Ideal for documentation and analysis since the original image remains unchanged. 

 

6.4.2 Exporting Measurements via CSV 

If measurements have been taken in an image, they can be exported to a .csv file 
using the CSV export function. 

In a separate program window, you can define the desired storage path and file 
name. 

Important: 

This function is only available after measurements have been performed! 
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6.4.3 What does Stich mean? 

 
Function: 

Combines all layers (including their measurement objects) into the image. 

This means: 

All measurements, text, and annotations are permanently embedded in the image. 

After merging, the objects can no longer be edited individually. 

Purpose: 

Used when preparing the image for export or sharing, and no further changes to 
measurement objects are required. 

 

Warning: 

This process is irreversible – once merged, measurement objects cannot be removed 
or modified. 

Always save a copy of the original image before merging. 

Only merge when all measurements are complete. 

 

6.4.4 What does EDF mean? 

 
EDF = Extended Depth of Field 

 

EDF (Extended Depth of Field) is a function that combines multiple images taken at 
different focus levels (Z-axis) into one image with consistently sharp detail. 

Purpose: 

In microscopy, depth of field is often limited. EDF allows structures at different focal 
planes to appear sharp simultaneously. 

 

Dynamic EDF (Video Window) 

Performed directly in live video mode. 

The user moves the microscope’s fine focus (Z-axis) while the software continuously 
captures images and fuses them into one sharp composite image. 
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Three Fusion Methods Available: 

Maximum Contrast (recommended) 

Weighted Average 

Overlay Method 

 

EDF in Browse/Thumbnail Window 

Multiple previously captured images are selected and merged. 

Advantage: Lower memory usage since images do not need to be opened. 

 

EDF in Image Window 

For already opened images. 

Disadvantage: Higher memory load and slower performance with many images. 

 

Important Settings 

Disable Auto Exposure during EDF to ensure consistent brightness. 

Use high frame rate and short exposure time for dynamic EDF. 

Move the focus slowly so the software can align images correctly. 

 

6.4.5 Notes for Practical Work in MicroscopeVIS2.0Lite 

 Calibrate before each measurement: Define the unit (µm/mm) and pixel size; 
otherwise, lengths, areas, and angles will only be displayed in pixels. 

 Use layers: Perform measurements and annotations on layers to keep the raw 
image unchanged. Export layers to Excel/CSV if needed or merge layer → 
image (F2). 

 Keep scale bar consistent: The scale bar length is based on calibration and 
the selected magnification. Always check after changing optics. 

 Stitching & EDF: For accurate results, keep exposure and white balance as 
constant as possible (disable Auto Exposure beforehand). For EDF, ensure all 
images have the same size. 
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6.5 FAQ – Frequently Asked Questions 

Possible FAQ Questions Answers 

Why can’t I see a live image in the 
software? 

Check the following: 
Make sure the camera is correctly 
connected and selected in the software 
(Camera List). 
Ensure that the microscope’s light path 
is switched to the camera (e.g., lever or 
slider for the camera port). 

How do I switch between the eyepiece 
and the camera? 

The microscope is equipped with a 
switching mechanism (beam splitter) 
that redirects the light path. 
Use the lever or slider to switch the light 
either to the eyepieces or to the camera 
port. 
Tip: On some models, a 50/50 split is 
possible, allowing simultaneous viewing 
through the eyepieces and the camera. 

Why is the image too dark or too bright? Check the exposure and sensitivity 
settings in the software. 
Adjust the illumination on the 
microscope correctly. 
Use the histogram to monitor and 
control brightness. 

How do I adjust the colors correctly? Perform a white balance, especially 
when changing light sources. 
Use the color adjustment feature to 
achieve natural color reproduction. 

The image flickers – what should I do? Set the Anti-Flicker frequency in the 
software to 50 Hz (Europe) or 60 Hz 
(USA). 
Check the light source (LED or 
halogen). 

Which resolution should I choose? High resolution for detailed analysis and 
documentation. 
Low resolution for fast live preview. 

How can I avoid reflections or artifacts? Enable dark-field and flat-field 
correction. 
Keep the camera and optics clean. 

Why are some functions grayed out? Not all camera models support all 
functions. 
Check compatibility in the Camera List. 
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How can I prevent image noise in low-light 
conditions? 

Do not increase sensitivity too much. 
Activate pattern noise correction. 
Use cooling (if available) for long-term 
exposures. 

How do I save images in the best quality? Select the highest bit depth (e.g., 16 bits for 
analysis). 
Suitable format: TIFF for lossless storage. 
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